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PART A: Grammar & Vocabulary Www.lIranEstekhdam.IR

Directions: Choose the word or phrase (1), (2), (3), or (4) that best completes
each sentence. Then mark the answer on your answer sheet.

&s'!.lg).obf:A”uza" >
25 L) gl G 30 QLRSI S g0 JolS 1) do ja JSb (i ST (4) 5 (3) ((2) (1) ©ole b 4olS il Jorll ) 9w
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41- I'll be there at siX ......uvvvveeeeeeee. | get delayed. Www.IranEstekhdam.IR

1) provided 2) in case of
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3) as soon as 4) unless
Bl Bl juSU ... 392 palgS LuT6 Cclw Goly o 41
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42-Tim asked me ......... oo, get him an ice cream. Www.IranEstekhdam.IR
1) that | could 2) if | could
3) whether could | 4) could |

S (s SO G|y e 4 gy o il e =42
oo g5 ge —4 oo ilg s UT-3 195 50 LT (lgs 50 SS1-2 95 50 (o 45 -1
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43- Those organisms that are most suited to the environment will be those that will

............. Www.lranEstekhdam.IR

1) survive 2) stick 3) handle 4) protect
ECTY PE S 591 3ialy> e T Bilosd 4o jlus Cam j buzmo (Sl 45 (513990 -43
03,5 laeSs (4 L oxsls )8 9 (3 (O3amnz) O3 S (2 o3k a5 (1

(35l sinlgs 0335) (1:4 35 plaseil Ol wliis)IS Geuly
44- The company president stated that without the active ........... of all the employees the

project could not have even gotten off the ground . Www.IranEstekhdam.IR

1) permission 2) involvement 3) procedure 4) density
3585 Ll iilgl g0d 1) 059 31 ol c0laio )8 plod Jl2d ... 093 45 3,5 Olo &S b ) —44
Sl Jos b3 S5 (2 o> (1

(Joe k) (3 :4 )5 plasuial Ol Golid IS fuuly

45-'m fed Up coveveeeeceees The rising cost of living and the high prices of property in the
city.

1)by 2)at

3)on 4)wite
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4 458 :‘ob.:'d‘ud Ol polis s cwb

46- Not everyone who takes piano lessons becomes affine musician ,which shows that

music requires innate .........cccceeeunes as well as training.

1) impression 2) talent

3) gesture 4)humor

47-A bank can generate ......cccccvevvnee in a variety of different ways including interest,

transaction fees and financial advice. Www.IranEstekhdam.IR

1) revenue 2) expenditure
3)commerec 4)amount
-0 Pl GBS g 9 rdos 3l G G2S| T ga Jolis 45 335 slowl £ 550 9 glise S GD9) I3 1) nreee 3ilgs g0 SGL-47
bl
Jlade(4 Oyl (3 &5')){_(2 ),.w)l

48-The ECB is very important to the euro-zone. Its main function is keeping

PriCeS....cvvevueennenn. in the euro-zone and inflation just under two percent.

Www.lIranEstekhdam.IR

1) Siable 2)previous
3) light 4) cautious
Mbuo 27. In),.s 9 L{J3| JDeeeetnnnnnenees Caoud 6)|).Q§J sC)T ‘H»M Jot «Caml e g rve) l.:')9| Y ECB-48
blio (4 Saw (3 o3 2 SrSe JiB(1

(1 :4 55 plaseiwl Ol ol ol )lS Gwly

49 - If had treated her well she ... Www.lranEstekhdam.IR
1) Won't leave
2) Dose not Leave
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3) Had Left
4) Would not have left

W) g0 Cawd jl 9l 35395035 Oloys 295> w1y 9l S1-49
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50- Before anyone could photograph the strange looking bird,... Www.IranEstekhdam.IR
1) It was flying away

2) It has flown away

3) It had been flying away

4) It flew away
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PART B: Reading Comprehension

Directions: Read the following passage and answer the questions by choosing

the best choice (1), (2), (3), or (4) that .Then mark the answer on your answer
sheet.

Good relationships between teachers and students are important for student motivation,
their academic achievement and also for teachers' well-being. Poor teacher- student
relationships are related to classroom management issues and are an important reason
for leaving the porfession. Teacher-student relationships develop from daily classroom
interactions between teacher and students. Positive teacher-student relation ships
enable students to feel safe and secure in their learning environments and provide
scaffolding for important social and academic skills. Many studies have been carried out
all over the world to study teacher- student relationships in various countries and
various educational contexts. All of these studies reported the significant and crucial role
of teacher- student relationships in education.

A recent study conducted by Jefferson(2011) revealed that teachers who showed an
interest in their students by indicating they were listening to them and understood
students needs completely and accurately, had students who obtained higher scores on
a standardized test of learning. By welcoming and encouraging students to raise their
own questions about the content or claims being discussed . the teachers could guide
students to develop habits of mind for framing and answering questions. Therefors,
when a teacher creates a climate of respect in the classroom and encourages students to
generate their own ideas involving scientific ways of thinking , students are more likely
to think deeply and persist in the face of challenges.

51- what does the passage manly discuss?

1)The resulls of a study investigating the effccts of teachrs behavior on
Students academic achient

2)Reasons why some students get high scores on a standardized test of leaming
3) Teacher- student relationships and their effect on students learning.

4) Ways to develop positive relationships in classroom envirment.

sl OljgoT G213 (6 5554 po b phoo puSU 9 gl 2313 9 pdoo o Luly) 2L (e (ol ey

52- what does the word(them)inparagraph2refer to?
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1) Teacers 2) Needs
3) students 4) scores
3 @iy ;8 splasinl Ol Gl IS Fuly

53- All of the following are mentioned in the passage as results of a good Icacher.
Student relationshipEXCEPT..........cccoeuu.. :
1) teachers developing habits of mind 2 ) stuents performing better
3) stuents feeling safe and seeure 4) teachers feeling healthy and happy
1 458 zplaseinl Ol el ISl

54-why does the author refer to the study con ducled by Jefferson?
1)To present an example of appositive classroom atmosphere
2)To give support to the claims made in the first paragraph
3)TO describe how a teacher can create a friendly classroom atmosphere
4)To inform teachers of the new classroom management theories
2 4y 38 :plasuinl Ol Gl )5 gy

ulyy slesl) Canl o3 4238 ol GBS 45 Canl plesl sl bl 03 0351 p33 BLELL 43 Ogmw i aawgs (s 4l
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PART B: Reading Comprehension Www.lranEstekhdam.IR
Directions: for question 55 to 58, read the following passage and select the number

of the answer choice (1), (2),(3) or (4) that best answers each question. Then mark
your answer an your answer sheet.

b S5 B gLy
LS @) 93)d2) (1) colez o cmwbio 4 35 e 9 3wilgdu 1) i e « S8L 55 OVlgw (sl 1ol g

S sk dolieanly 3 1) 395 fly g 3uiS OBl 383 g0 gy ) Jlgew s JSb 0 sip2

Indeed, when asked what they liked best about their workplace, employees at top-
rated companies were about twice as likely to say they felt "genuinely appreciated"”
at their job and confident in the direction of the company as they were to talk
about pay and benefits they earn for working there.

That’s no surprise, said PeteFoley, head of the Employee research Group at human
resources consulting firm mercer. It s not that pay cheeks don’t matter. Obviously
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they do. But when it comes to creating enthusiastic, engaged employees, money
alone cant buy you love.

" Pay and benefits have got to be at a minimum level, and then you're on to other
things", Foley said. " you want to know you can develop, have a sense of
accomplishment, feel like you're making a difference".

Many of the companies that took part in post-dispatch survey are relativelycollar.
But the same concerns about development and dignity are seen across the ruum of
business. When local fast-food workers launched a one-day strike last day, their
complaints were as much about working condition and treatment by visors as they
were about higher wages.

That is not surprising. Foley said. Surveys have long shown that the way people are
treatedat work means at least as much as their compensation. Often more
Www.lranEstekhdam.IR
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55- The passage suggests that people who work for a company ...
Www.lranEstekhdam.IR

1) begin to care about working conditions when they have no financial concerns
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2) are more likely to go on strike when they do not have the right to behave at
their workplace the way they want to

3) sometimes get more satisfaction from the feeling that they are valued than from
the money they receive as their salary.

4) expect their supervisors to conduct surveys from time to time to find out much
the employees like their responsibilities.
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56- The word " do" in paragraph 2 refers to ................. Www.lranEstekhdam.IR
4) matter 3) work 2) consult 1) pay

e 3l 2L 2 Jl)?l)li. 2> “do” 4.ds -56
(bls Cuonl) matter -4 (03 ,5,5) work -3 (03,5 9e)Consult -2 (@si>)pay -1
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57- According to the passage, PeteFoley.................... Www.lranEstekhdam.IR

1)directs a group of researchers

2) criticizes employees who do not consult whit others at their workplace

3) believes employees will never complain if their pay and benefits are below a
minimum level

4) was once a sad employee who became happy after the result of a survey were
implemented at his workplace.
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58- The author mentions fast-food workers in paragraph 4 primarily in order to
................ . Www.IranEstekhdam.IR

1)demonstrate their concern about their living conditions.

2) generalize the main point of the passage to workers other white-collar
employees.

3)emphasize the adoption of strategies intended to prevent any unrest in business
companies.

4) illustrate a case in which the finidins of the post- dispatch survey cannot be used
to analyze the employer- employee relationship.

3538 bzl ... ohite 4 brac 398 Cand OIS IS 45 23S o ,S3 4 BLSHL 43 5wy 95 -58

395 S35 bl b o)Ly S5 Oslsolis -1

S5 Olsia )5 s 4 0SS 4 (e ol 455 puoni-2

S5 S 1 3 (o) TU 695 0 1 25 9l sl A3 90 S 351 piasl Garkis 2 35T -3

3280 30018 — Lo 38 dhuly Jukoxs (50 Olg5 g0 |y POst- Dispatch oiw pbs slaaidl 01,5 45 390 S 03130 -4
I i 6 )15 Byl pid 1 Lo )b pbls 4 395 Cand OIS IS A GBILSLL s (1 cai )5 plasiasl Ol Golid IS jeusly

293 olaiel 4 Cuws (awl (S 355

59- The meaning to paragraph 1 is closest in meaning to... Www.lranEstekhdam.IR
1)medical inventories

2inventing
3) supporting
4)financing
(1 14535 plaseianl Ol wliis IS guuly
60-The indicates that high —level specialized hospital.......... Www.lranEstekhdam.IR

1)keep all their items in one inventory

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



pl.&é&wl 0| |

2)keep their inventory at local clinic
3)dont usully keep an inventory of their simple items
4)update their inventories frequently

s slaiwl 9 Ghon

9 DT D )go DI c).b.o dl;.w).b))Glj k,....ns,.o Sl f’)” O3 61L§Lbd|,.w4a@,§-‘>li slo :G_{lo.i.bb
g 1 3538 Ol aml Ulgow 0T (8l (8 )5 cmwlin gianly 35S 5o S5 45 1) (Sl4iz 35 s 9 3483 415 Julons
BB Jy 0285 Ol 9 038 Oy 45 (2l 9 Jlgaw s U3 23d 7 pho slacusdly 4 4295 b 9 duilgsw s L L

2w o Caole Ml&é@ml._f_)),c_.)l.‘idﬂ ¢M)@)Ei4g)ﬂemo4s|) L;'m»b Cannl CL.......J

2 J9pal ey CannledT 03,5 36 9 OS> S J1 035 iy po5 oS Sleiiay eadlys g0 g el 45 Sl s 15 -61
sl 350 OLEIS 32 45 U 45 00350 9 @S iy p23 0395 Jle 9 a5 )51 > S O

TS (g0 a9l |) (o ) 83k 7 o Ao gl Ay (2 g2 4 D guid b i &S ()90 )3 03 )90 plaS
Www.IranEstekhdam.IR

lo o JBLe LIS bl 5,515 1 45 sisd 395  pased Jilao 2853 2T o131 1 (5 ks (1

L VU € g s Oliws o) i disS g0 Ly 25 O1SSS 1 45 (631,31 45 aa3 g0 YL Olduiss (2

290 082 Uil 391 13 (6 fidn LIS 3Bl ol ped o ol Wa ol (slo julr b SS1.01Es5 Lg5 IS 1 oIS iy o5 (3
Syl sl 8l

130 T 4 95 I 01S S I 03 3l ol 9 3515 O 30T 4 Lo lapsT (4

oS 25 OS5 SIS jl x5S o 45 )3T b 4y azgi b (4140 55 plaseinl Ol bl fuly

39 by Gl 39 21> ereuas b dtad OT L s po o) Jl (S b dow owlisd IS (55200l5  puil> Jl> 3 )S1-62
L sosas b ;95 Slon S pb 13 Vgoro dow (wliid )l G 3wl OT (o 03T 9 SIS L 2,)L)3 (508 s

Sl 3V (B Lol 03 15 0 plol S b JS15 3 dowy ol IS SIS 1 (ol -390 50 IS 4 Jgiiio LT sl S sl
Tl G935 JYstanl 43 pitane ) 8 Sy 0390 pIAS .38 42| po &S i Jl g5 B 3590 Yoo s (2l obL0
Www.IranEstekhdam.IR

399 2ilg iy jl 53890 393 0k T Jid )3 (aiS Ll ) Ol pbis 390 i) 395 Blhe L 4595 b 45 SlwsS(1

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plaseicw! ol o

8L OT 68 Byl b 9 )b 4 4265 b 3ol ctiid ) Ol sladalgs jI (S (3
3597 50 395 JLis 4 s i Colowd 3idl o Ol JolS 28T LS g0 )30l ros it ylugows iy (4

'o.ubu |))l$)|)'l.396hi&b&TAﬂJ@GPQAh}QQQ’Q 3 a5 f|)..7'd.w| Ol | o, ls Ewl"

O 9 Sutunl 3uS puo S g0 12l 835 (i go «OLLS JUS (B9, 45 32395 9 33 g0 3) 2905k Jl bl 51-63
....................... 35 j 50 boud (51 LT .3wiS 68 Ol jlw (slowo

Www. IranEstekhdam. IR S o JolS 1) $93 (yio 13 J sl (JSb 0 5 sibrio 42350 plaS
St iz Sl T 9 b 09 (1

2l g0 1) ol s 395 Jo (¥

Sl 5 S5 Lo (510 ¢ pmuiS (2l 9 (V

33135 o2 203 U ol Sl el (S s 4 9 (4

2l 2udkS Caom g 33l 03,5 2 red Ul sl 09z (424 ;5 plasinl Ol ol jwlis)ls &b

T 505 )13 3L s3e plsS (Jlgw Caolle Gl 4.l Y13 10 pols bl )l slael g ¢ ) sl JSB il plsS o > -64

Www.lIranEstekhdam.IR

20 (4 16 (3 122 8

(124038 plaseiool Ol pal ol IS Geasly

3Ll ) buwg 33 9 03 0 pd ob 2 Juol> 332 93 (l 9 03 oS o I Camsly 9 az Commw 332 93 9 o2 Jl ol 9 Vb 332 93
S o

8x1=8 5 (7-15)=8 5 (8-9)=1

-\ «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plagasl oyl

el o ol (21 45 398 g0 B Jlgaw 3935 dluno 359 g0 03Ly JUB I 45 Sl pSlune ol 12 95 ¢ 9 %0 8t ST 45 -65

33l 0325 lgun 0Bans] 2l 43 O pdluso 1 3u0 5 3izz S &S > jl 3 39 g0 S gl O pdluno 31325 (S3053 60 ol 53
Www. IranEstekhdam.IR (€ s Jd Ol dlue obe L) §

40 4 303 252 20 (1

@ 435 plaseianl Oyl pwlid IS jeasly

ea13 2b 53 23y Olpdlue 31323 Y9 bl Ol Slue 4l slazs X S

X-y2y=X+(0.6X)
y=0.6X

iad 49l Ol pdlue 300,3100-60=40 ¢yl 0l

29 bidi> Olizron bl ol B3 550 S8 2L 332 p13S lgms Caolle sl 4 .l Y13 0 ol b5l ) slael s —66

213273 .333.423 .543.693 ¢ Www.lranEstekhdam.IR

873 4 783 (3 753 (2 943 (1

4 4y 38" :plasuinl Ol Gwlids )5 gy

Sgdue o 395 by 03 30 3y b 332 a8 30 5,
(2%30+212=273)
(230+273=333)
(3%30+333=423)

(6430+693=873)

S o pann 93 9 3L Cagr ($lg0 ) paamno 03 B el G A g 393 Slg g s 23 S p3lee Slomlsn S 607
L e O b lod Cae puw Cand w3 42 (lieS o Olo) D30 4 ) Ol e s 3S g0 OS> 3L Gz BUS
Www.IranEstekhdam.IR Scwl plss

143 @ 2450 145Q 243 (1

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



2 4,8 :‘ob.:'d‘ud Ol polis s cwb

X=¥
Ve +Vy Vo—Vy VeV, ¢t
= — = —
t t, V, -V, t,
V., +V, 2
== 2V, —2V, =3V, + 3V, =V, = 5V,
VH_VH 3

Www.IranEstekhdam.IR $sls J13 Olgs o 1) 43S plaS Jlsw Colle sl 4 ) Jgaz s> —68

1@ 43 22 3(1

31 2
2 52 3
3 63 D

Jsl Ogiw 332 0313 )13 51 LG s 9 35S oo Sl ) 93 Ogiw OB 32 9 83d o> pgw Ui b gl Ogiiew b phaww y>

S g0 Soul

6=3+3

Www . IranEstekhdam.IR :awls 1) jlade Jolio sledSd 4 4545 L-69

584 383 18 (2 16 (1

DHD

ol 10 sleio oy 332 93 © b S ygu0 4 Al 05

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plagasl oyl

12x4=48  948-10=38

°>)S)I)s »bose fl)Sdl;w Colle lo 4wl Y15 0 G"l’ bls )l )b&'w‘wbbu.?ﬂ o ydlael 42.'2:)))-70
Www.lranEstekhdam.IR
28, 38 ,49,62,70 ,77 , ?
91 4 89 (3 87 (2 85 (1
STl Canl iy dalsl ;316 359 (2l 9 Cawl 22 3wl pgs e 9 daud Lol sae QTQ,&@.‘? 9l OB 9 OIS sac 95
90 91 Juol> 59 48LoI 77 4 9 Rex> p2 L7 S22 93 £ g0ore

7+7=14 77+14=91

Www. IranEstekhdam.IR § cwl plaS X 4 Y Cod o9, 19, slael aud, ,5-71
0 26 14 x 62y 254
32 21
5/1¢4 4/2 3
A 0 > 45 (5332 p3> U 0 > . Cawl 02 Juologd 332 9 23 Rex (gl 332) 332 393 U 5 20d Lol 315 95 Jgbdae 4
25#2)+2=6:L ol pow 33 G Gl 03d o p95 332 b 9 Cawl 238 2 )39 i (3219 93) 592 225 4BLSI Ul
:@ulbﬂﬁ)d))wﬁf}%)xﬂﬂéwlz4.3»|94J4.§4J.>)4))
2x(4)+6=14
i3 Bae J505 Sl i 5 (ued @
Xx=2(8)+14=30
62 =2(16)+30
y=2(32)+62=126
254 =2(64)+126

y_126_,,
X 30

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plasiw! ol !

1 3
1S ously o aizred 351> eb (550 Jod (0L ‘_‘,_s|‘—1 Dad g0 JuSis 0L 1) OIS s ali.i‘:l.ggS._a.Lng.clg =72

48 > o bid a8l ol )3 A4S SULSS jus JS slaei LS ok ju (5,505 Jod bl a&ab ol )3 5 ol)lf.s),.-:»%
Www.IranEstekhdam.IR Scuwl plsS sl ol 0BG o3 JS slaes il a5 430 bl g0 Jgiie (SIS 05
1000 (2 1200 (1

600 4 720 (3

4 4y 38 :plaseinl Ol Gl )l gty

125l (5 s Jis biib 45 U j

39
—X— =
20
13515 SIS o3 Jois baidd 45 Sl re
4
—X— =
15
13515 IS pu3 Jis baidd 45 QU 9 Ol pw Slos
9 4 43
- — =
20 15 60
o 3513 (§ 0 i Jaid i a3l 43/60 o9 1Sy b5 43 X 1) oL sliael 5wy 51 Jl>
43

—X=430—> x=600
60

o VLS ) jeb jl a4 Cclis 45 Canl (5l 495 @ (sl @ i Cclin S5 Lo 4 9 Jlod Caelw sl @ jic 4yl Joo - 73
T390 3dlgs 45 3z LT o 9l 3wy (o0 Jledd Calio e 4l oo 4 b udsl 1w o b e €S (Sloj om0
Www. IranEstekhdam.IR (95. 5,5 5 9 yisel)

10 2 S(1

124 113

2 43y 38 rplaseianl Oyl ol IS Geusly

360
C«J‘-L»Q)ic&udc)ha)&gﬁ.:s}zoQRJB.W&|?Q)33O4§»‘ZQ@E Caelw g 425 Oljwe sl (gl

o 4B 9 Lo Cucluw oy 49l G 35S JolS 1) 595 4255 30 sy 4iB> 40 U oS oo (b 42,5 10 4ids 20 ol ys Jleis

W AA',."? 4> 10

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plasiw! ol !

),JJD)')&HHU@A;LM?)X?) s'o.a)|))lu.‘>|))4sdl.bwlsIo....SWISb)a)JS.me)‘u.M,?@ -74

Www. IranEstekndam.IR Scwl plaSigb so5 bIS 45 o) o2l Jl (FZolane (2 208

Fy ' =
+1§—

170 2 171 (1
130 4 121 3

91 42,0 OYgame G 35S (0 03Lo 2 42 5 9 1 425 CuisS 93 )3 plol . G238 ¢ iy Jgnamro £95 dw (S )b SO -75

Ll 7 08 s U i 5 U2 4>

plak . plob )
g GWd
IS U G SSW5 4 S1)3lo 2 425 WY guaze w0 ) 203 4 Jgwaze b Ol yslo Ol jue

Www.IranEstekhdam. IR Scwl plsS oai y3lo Jgazo o piies
Pt SepEG 922 S (]

1 43y 38 splasuil Oyl yolid IS by

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plaseicw! ol o

(GBain sl & )lgo) J5garels

Ta9d g0 E9 0 b2 pI3S b (o b Loy Job 4 cpasd i suelS Sy Sixe S3215 5138l 76
Www.IranEstekhdam.IR
A@ D@3 Cc@ B

s G;l:u’-l‘ Jlosamd sladbl) )o @l) S)lasbiwl 4 Csew S > o35l g 2 THLY 'p|)..'5€i.w| Ol polis s cwb
02 P g0 413 .ad LT C G, jl gam SIS pL 3559 238 0313 Hamass Olg> LU0 slaglys B 9 AL > 95

D313 salgs &)« 2 390 plas Enter g Ctrl slasuds Olo jod 0313 JL23 b Word siw SG ,3-77
Www.IranEstekhdam.IR

paragraph slesl 4 o3, (2 paragraph olxsi(1
i slel 4 38, (4 332 doiuo S 3wl (3

D adlgS 3 9 JS15 )3 e sdxio SO sbul el ctrltenter 48> (3 14 55 plaseial Ol Golids IS Zuwly

plaS Sl .aums Giales Jgaz Sy JS& 4 1) Gy ol aalss g0 9 3ules ;5 Ol | Excel b S S0 )ls S il s -78
Www. IranEstekhdam. IR SauS s a3kl )15l

.(4.(3.(2.(1

2 4...:)? f|).:'=2w| ol pl U»U.J'b)ls Cwb

- 0 2wl 39 00 22Dl 2 (54 35 > a5 format as table jl Jgaz & g0 4 EXCEL I Lisw 0sls Giules sl m
giage 8313 JUES! 155 3 90 OlSe 4 Gugew 9 83,5 SIS ez phi 30k .3b 3 salgsle o 030li33,5

Ll i 9 Ji siilgs o Olaie IS 45 (5 usb 4 o3l o Jusrto 450355 43 B 5 garelS « QLIS Jomo 43 23S o8 -79
T Canwl 035 03likol 45 £.95 pIS 1 ¢SS5 385 4 s 5 gupolS Sl 3 351350 STl 4 )53

Www.lIranEstekhdam.IR
WAN @ TCP/IP (3 LAN (2 ISDN (1

-\ «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plasiw! ol !

LK a0 SO bl SO siile (S265 oldl ez 239550 45 Gl (sl LI 45Ul S (Local Area Network) (e S

394 50 0ol A £95 (Sl ... 9 Dlzo ol )3 Vgono 9 385 00 Jhudisy ) YOSl RIS

Www. IranEstekndam.IR § cwl Joe plaS Jslee ¢ Y 9 Ctrl slasulS us 5 -80
Redo (4 print (3 Undo (2 cut (1
JoB 5 Jled Undo b 033135 0 Joe Jjl yuy 45.38L g0 1€d0 Joo Ctrlty sdS (4 i ;5 plaseinl Ol Golid IS wly

o),a':nn-o aalawl

=y LgsT 4 CPU 45 sl (ol dliSlo 1555 40 Cpuass (550 Cand pbs 9 iy (o piawd as paw SI> ldl> plss -81
Www.IranEstekhdam.IR $s,ls

ROM RAM (3 Cache (2 EROM (1

2 4y 38 :plasriusl Oyl ol IS Granly

Elsil 9 ply Cusd 15 . 2ilae ROM (sla dlidl> glgil jI Sy 9 238 4 gs EROM slizisl 4y 45 535 EPROM Ylosim 1 4y 38
sl 208 it OT (g a3 a3 323 (0 b 43S 4y 1 28 S0

b ol ohS iz j1 0T pox> CPU g95 4 i 9.3,)15 1) (g w3 (25 @ SCPU @ dlidlo gy 05 55 (oS abidl> 2 4y 58
3L g0 coblEs 12

313 el 9 GES 4 s (605 ey 9 313 (i Jus alisl> RAM

Www.lranEstekhdam.IR
Citation (4 Subdocuments (3 Outlines 2 Bookmarks (1

1 a5y 38 :plaseianl Oyl Gwliis 1S gruly
Jizio O OT 4 5 S)bS 5 0T 590 SlS LG 5,8 a1 5156 Olg5 o Bookmark 1 aslizwl b 3,9 41381 p 5 4>

D gab

«(Slide Show) 51l ol 3 Jgiels s sg Wl 4 3 9 (Sl G99 25 cawlio « Power Point 2007 181 p 5 55 -83

Www.lranEstekhdam.IR Sl plas

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



Slide Show slas Ol )5 ol 9 e 4 CldSjL lp Cawl) 9 oz ez SIS Sl skl (2

Go to Slide 23 b5 590 30l Ol 9 3ol (59 2 3udS sl @

4 4..4)? :|o|).7':.'i.w| ol sl U»L;.&)LS e.ub

Tl Jljal plaS 1 ool cxiw Olod 3 (§ )55 Hidu b siw jl Gidn SO Cao d (il OLaSS (sl 81y (2 5 85l -84

Www.lranEstekhdam.IR

View (4 References (3 Font 2 Format Painter (1
(1 @)f |a|)..7':2w| ol sl u.,L;..-;-ulS c.»l.o
Ulgw 4 (S 0 4295 L .odd o0 OLES 1) (SSL gol g g 30 4l OLgmisls 3,5 sLasBl w)d Ol red < ) S 1 2 loial)

a5 gl 50 647 sla

Www.IranEstekhdam.IR $3g& o s3litwl ygkiio plaS 4 Power Point buse ,5 Transition Ll 3l -85

JB SO Grales g9 (1

Word LB SO 4 L1 Jas 2

sathosl Sy 3 g Sy (Sl S pio (3

32 3Nl 03l g 3l o O 9o pgm (4

Ol 4 i3 (50394 0 4iS IS i3 Wanl y> Wy Vsl O3 palB 095 4y (4 14 55 plaseian] Ol wlids IS Geusly

e QLS 4258 (pl 9o Wanl (S0l 94050

Www.IranEstekhdam.IR Scwl cuwlio 3ulS p13S 1 o5litwl. 3l 48,5 1,3 Word siw Sy, b G slewly> -86
Tab 4 Enter (3 Delete (2 Backspace (1

Sa3wo ) 32y jha 4 (38 Ol ek 4 Enter 438 (3 455 plasuinl ol ol polis )8 Zwly

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plasiw! ol !

csliocJos ol plamil (1 prepl3S .38 Jlos! Ogio b 9 1) WOrd siew o SIS (sl o b sudlgsusanS oy 87
Www. IranEstekhdam.IR €l

@25 (5o SeS Font 15l (1
o Jlocl b33 )50 (sl i (530 03,5 SIS Ly 953,5 SIS Format Painter g, 9 43,5 1,8 Jsl B3 (59,2

S

< Jlesl )EJ.)),A s uuau sy Format Painter Joe u»,l.o U.wub ELY] u.ul.: Lo 4..9)?)')9 Jsl d')f')la ,53)(3

Oxod 903,5 Okl B> 1) Oge wlw ) 55,5 SIS Format Painter (g9, 9 43,5 ,1,3 Jsl Csl)fl)l:. o) 4

oS (5o Jlel (o 2 sl 1) Jose
4 a5 ‘ob.?'d:.w| Ol ! ol s C.wb
format uhu|3cuMuTulan|bP.~b>MJalsﬂts)gaéwdwgsmlobl)dob)lwm&u,94s..4|6|)4

plos Jlosl 1) Cogd s ouilgs g0 45 390 e Ol yuaw 9 painter

Www.IranEstekhdam. IR $cuwl 2o plsS 4 ywg 9 515 umalS e )5 -88
398 (g0 S 9molS 4 w9 29 909 @lo 45 (51531 p 5 (1
-390 15 garalSguun9 22939325 Lo 45 (5 1381 S (2
D9 (g0 0Lkl g 9 035 Ak B b B3> 9 jauis g 45 18l p s (3
223 g0 EUbl IS 4 5garalS )3 w9 29 3979 L ygeo U3 &S (S| L 4
(1 a5 ra|.\:l~d:.~u| Ol ! pols,ls C‘“L’
ol a1 €338 o9 m9 5T sy 4 4295 b Jg 3L o wo 9 ST By Jolds o 3 iy 38
L w929 Jold 181 SLbT slagSil Jss 4 b 5359 53 (Slgste (o) 9 830k b 45 Canwl (51581 p 5 1 w9 129 55T
9 lod )3 9umolS 4 OT 59,9 jl 394 50 43S wg p9 bl OT 42 45 g3l cpl 23nlike )90 43 .253 )5 g0 (S 5] S S |
o b 9 23S B3 1) BB LT 45 35,5 (g0 ygiws Lad jl 9 33 g0 1y p5Y Jlaied Lok 43 b 9 3S 0 (55 9lr G210 |2

23S S 9 ol 1) 0T iples

Www.IranEstekhdam.IR $sas o olizs Word2007 siw G s 1) Tab @) bys o Olowbits geazs paanno> 90 plaS -89
Page Layout>Page Setup>Tab (2 Home>paragraph>Tab (1
View>Window>Tab (4 Insert>Text>Tab (3

(1 2438 plasuiul Ol gl Goliss S ly

e AD aaSs g 003 1, GBI S1L anSshome  isw ,oword2007 ;s tab a4 by e oledas sl

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plagasl oyl

Sl fb'J ‘H)lé o S— ))_) 9 Ctrl SIS H b 4ot Word 2007 J—al f»)_ﬁ 2 -90

Www.lranEstekhdam.IR
S Ol b 1wl jl s Olssl (2 S8 S slal 4 o (1

b glxal 4 b g (4 S 4l Ol (3

1 4y 58 splaseinl Ol polid S Gl

Www. IranEstekhdam.IR §cwl cuslio Jge b plaS « AIFA2+A3HTBATBSHBOHT O )le dunlore sl 4 -91
SUM (Al: B6+7) (2 SUM (Al: A3; B4:B6;7) (1
SUM (A1: A3+B4: B6+7) 4 SUM (A1+A3;B4+B6+7)(3
1 4 58 :plaseinl Ol ! yulid S gl
9 A3 U AT jl pamsgis b Oobe oz sl gy 215 1" 9" pogie s Cialle 9 3)15 1) "B pogio T Cuolle JuuST a0l 0 s

2T oo Cawd 41 4535 &)le 57 3329 BOL B4

Www.IranEstekhdam.IR § cul ums 3,50 plaS « Aeecss 133l p 5 busmo 53 -92
Cawl 355 ) 0313 2554 S s (Slelbl s>l o 5 SzS (1
ol yiiy Memo 0313 g5 i1« Text asls g5 01351 2
)15 3929 Jsls= o (Relation) bls)l oSl (3
D15 3929 23013 2L s SG U 3z dl) (4
2 48 splasiul Oyl Goliis IS granly
bl oo Cap 32y (g )iS2sS
Canl grazeao 2
)13 3929 Jslsz o bLi )l OlSLI 3

DS 0bul Olgs o LN L S @ 2z 4l 4

TowiS o0 Jor 498z 390 Lalb Coll by S =i YU WORD siww S5 )5 saless ,51-93

Www.IranEstekhdam.IR
Text Box jl sslazwl (2 Table ;! sslawl (1

dxino ya YU 5 )90 wbgs 03,5 oS (4 Header jl sslawwl (3

B 4S8 plasuiwl Ol i )8 Gl

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



plagasl oyl

3905 o3liiwl header cuoud INSert isw jl 3l dxio juw (g (510

Www. IranEstekhdam. IR $35 0 Jitie a5y pl3S 4 lxil oad B3> ol ¢ oSouig xSl Canmny S 43 -94

Spam )4 Trash )3 Inbox )2 Draft )1

2k oo Jsl TRASH isw 4 0aé B3> (540U « S Sl Gy U3 (sl B3> L

390 03kl i iig| b bL3 )| @hS Cagr 390 p1aS 3yl 00 Judtio i iyl 41 395  puaseid )5 gusalS G2 b I 2S5 8 -95
Www.lIranEstekhdam.IR

1) Disconnect
2) Eject
3) No connect
4) Close
(1 :a0 ;5 |o|).>'=2.w| Ol ol s c.ub

2Ll CONNEVL jl syl b5 30 p350 S 4 JUasl (512 9 - eales a3kl AISCONNECT jI cunndlS o il JUas @hid (sl 0

3909

- «pladaiwl ol b el walys Sgld o Ky (LS jlUasl g0y cgzogm ol 8l lawgy LB cpl Ll 4568 o



